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Executive Overview 
The following information contains documentation for the planning of the 2017 Autodesk Product 
Design Suite and Vault Professional upgrades.  The total upgrade installation time at RyourCompany will 
take approximately two months.  The timetable includes strategy for all global facilities.  Autodesk 
Resellers X & Y will be contracted to assist in the installations along with RyourCompany I.T. group.  
Training days will be scheduled for Inventor upgrade to 2017 tools and features along with Vault 
Professional Training on Lifecycle workflows and ECN’s. 
 
Target dates for implementation at all three sites are scheduled for September 2016.  Prior to 
installations, all departments will be alerted as to when the Vault server will be down and when their 
users will be out of commission for a short period of time.  Both China and Buffalo are part of the 
strategy and will participate in the implementation. 
 
Autodesk 2017 Product Design Suite(s) comes with an array of applications.  Prior to creating 
deployments and running installations, a Cad team in conjunction with I.T. will decide on which 
applications to install and then create deployments for distribution.  Deployments may contain all or a 
specified set of applications. 
 
The Cad team will have a test environment established and that configuration team will finalize the 
strategy.  After completing the installations on each station throughout all of RyourCompany there will 
be an orientation per department to understand the tools that are on each system.  Each Vault 
Professional seat will have a domain login exactly like the user’s computer login.  In addition, there will 
be added security per Vault user pertaining to their role and permissions.  
 
Training sessions will be scheduled per department as needed. All Cad Designers (Product & Projects), 
Engineers, and Managers will need to attend the Vault Professional training session(s). 
 
RyourCompany shall and will refer to the “Advanced Configuration Guide for Autodesk® Vault Server” 
published by the Autodesk Vault team. 
 

 

 

 

Executive Overview Specific to RYC (China) 
The following time lapse of Vault Replication Synchronization will be planned and rules created for 
continued work over a period of 9-14 days.   See separate document documenting rules for continued 
Cad Designer work.  Reference document 2017 RYCS Rules.docx 
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RyourCompany Autodesk Software 

Overview 
The Autodesk software applications shall be installed and run with network licenses from 
RyourCompany headquarters in Export, Pa.  The order of implementation shall start with the Autodesk 
Document Management Server (ADMS), continue with creating Deployments for installation and 
completely test and implant RyourCompany Vault configurations for lifecycle management.  The 
replicating Servers both in China and Buffalo will also be upgraded simulations to Export. 

Applications and Seats 

Americas 
o 100 – Autocad Product Design Suite Ultimate 2017 Network 000-00000000 / 000I1 
o 100 – Autocad Electrical 2017 Network    000-00000000 / 000I1 
o 10- P&ID 2017 Network      000-00000000 / 000I1 
o 200 –Vault Professional 2017 Network    000-00000000 / 000I1 
o SQL Full Standard per Facility 
o 50 – Autodesk Inventor LT Suite 2017 ……………………………………. 000-00000000 / 000I1 

China 
o 100 – Autocad Product Design Suite Ultimate 2017 Network 000-00000000 / 000I1 
o 100 –Vault Professional 2017 Network    000-00000000 / 000I1 
o SQL Full Standard per Facility……………………………………………….. 

 

Europe 
o 100 – Autocad Product Design Suite Ultimate 2017 Network 000-00000000 / 000I1 
o 100–Vault Professional 2017 Network    000-00000000 / 000I1 
o SQL Full Standard per Facility……………………………………………….. 
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RyourCompany Vault Server Tasks 

Servers 

Autodesk Data Management Server A 
ADMS resides on a Virtual Server at facility A in the Americas 
Main Vault Database Hub 

o The Vault server is: RYC-VAULTa 
o Restore current Vault database to ADMS 2017 

o RyourCompany  
o RYC 
o Content Center files 

 RYC Library 
o Migrate Vault Data 
o Migrate Inventor Design Data Styles and Templates 
o Create Product Design Suite Premium 2017 Network Deployment 
o Create Product Design Suite Ultimate 2017 Network Deployment 
o Re-Task backup script and add China to task 
o Add RYC China Inventor archived data to RyourCompany  database 

 

Autodesk Data Management Server B 
ADMS Replicated Server at the facility B in Europe 
Secondary Vault Replicated Hub 

o The Vault Replicated Server is: RYC-VAULTb 
o Migrate Vault Data 

 

Autodesk Data Management Server C 
ADMS resides on the Engineering server at the facility C in China 
Secondary Vault Replicated Hub 

o The Vault Replicated Server is: RYC-VAULTc 
o Install ADMS or AVFS 
o Copy the Vault Filestore for ADMS 2017 replication (Full?) 
o Transport External Drive to server  

o Vault Databases filestore 
o Content Center files 

 RYC-Library Filestore 
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User Stations 

Individual user stations (Facility A) 
o Check-in and/or add all Inventor and Autocad files to Vault 
o Save all custom configurations by user 
o Uninstall all 2016 Autodesk Applications 
o Install 2017 Autodesk Products per user station 
o Sign-in to Vault through explorer and Inventor 

o User Domain 
o Download Project file and activate 
o Reconfigure any custom settings per station 

o See User Installation List 
 

Individual user stations (Facility B) 
o Check-in and/or add all Inventor and Autocad files to Vault 
o Save all custom configurations by user 
o Uninstall all 2016 Autodesk Applications 
o Install 2017 Autodesk Products per user station 
o Sign-in to Vault through explorer and Inventor 

o User Domain 
o Download Project file and activate 
o Reconfigure any custom settings per station 

o See User Installation List 
 

Individual user stations (Facility C) 
o Check-in and/or add all Inventor and Autocad files to Vault 
o Save all custom configurations by user 
o Uninstall all 2016 Autodesk Applications 
o Install Autodesk Products per user station 
o Sign-in to Vault through explorer and Inventor 

o Vault User ID 
o Download Project file and activate 
o Reconfigure any custom settings per station 

o See User Installation List 
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RYC-VAULTa Components 

Autodesk Data Management Server Console (ADMS Console) 
The ADMS Console is installed with the Autodesk Data Management Server, and is used to administer 
and monitor the Vault Professional server components, including Vault backups and site to-site 
replication. 
 
User and Group administration is performed from the ADMS Console as well. For RYC, Vault Professional 
is configured to use Windows Active Directory users and groups. To grant permissions in Vault 
Professional, the Active Directory user account should be added or removed in the appropriate Active 
Directory groups. It is then necessary to “update” the corresponding group in Vault Professional Group 
Administration dialog to synchronize the group membership changes.  
 
(See the How-To section in this guide called “Change Vault Professional Permissions for a User”.) 
Manual Vault backups can be made from the ADMS Console (Server A ONLY) as well. The ADMS Console 
Backup function produces a “snapshot” backup that includes a copy of all necessary database 
information and all actual files. These backups are sufficient for restoring an entire Vault in the event of 
catastrophic problems. 
 

ADMS Administration Settings 
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Autodesk Network Licensing Service 
The Autodesk FlexLM licensing service runs in the background on each file server and automatically 
manages available licenses for all Autodesk products that were purchased as network (floating) licenses. 
Any Autodesk products licensed as “Standalone” are not affected in any way by this licensing service.   
 
The LMTOOLS utility on each server provides the management interface for configuring the service 
and also allows administrators to view the available licenses and licenses that are in use at any point in 
time. Once the license service is configured properly with a valid license file (obtained from Autodesk 
Registration at time of product installation), there is really no ongoing administration required.  
Workstations in each RYC location are configured to get licenses from the applicable local fileserver 
(RYC-VAULTa, RYC-VAULTb, or RYC-VAULTc). 

IIS – Required for ADMS 
Microsoft Internet Information Server (IIS) is installed and required on all Vault Professional servers – 
both at the master location (Export) and at all remote locations. The Vault Professional ADMS Server 
runs behind IIS and receives traffic on port 80.  In order to reset the Vault Professional server in the 
event of problems, it is only necessary to perform an “IISRESET” command on the affected server – 
restarting the Web Publishing Service. 

Microsoft SQL Server 2012R2 
Microsoft SQL Server 2012R2 is installed on the RYC-VAULTa server in Export and hosts the database for 
Vault Professional globally. There is only ONE database for Vault Professional and it is hosted on RYC-
VAULT. The Vault Professional ADMS servers at all other sites connect remotely to this SQL Server. In 
this manner, data consistency is assured.  Backups of the SQL Server database are performed as part of 
the ADMS backup function, which is scripted and scheduled to run overnight. The ADMS backup makes a 
snapshot image of the Vault Professional database and all other remote sites. 

RyourCompany Server Configurations 
RYC’s Autodesk implementation utilizes file servers in each plant location for a number of functions.  As 
of this writing, Vault Professional ADMS will be installed on servers in the Americas, Europe and China. 
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Americas RYC-VAULTa 
Autodesk Network Licensing Server 
Vault Professional Server 
Components: 

o Vault Professional ADMS (Autodesk Data Management Service) 
o Microsoft IIS (required for Autodesk ADMS) 
o Microsoft SQL Server 2012 R2 
o Shared CAD files (templates, etc.) 
o Autodesk Software Deployments for Workstation Installations 
o Vault Backups 

 
The Autodesk Network License Manager Service is installed and is named “Autodesk Network 
License Manager”. Restart this service in the event of problems obtaining a network license within 
the Americas facility. 
 

Europe RYC-VAUTb 
Autodesk Network Licensing Server 
Vault Professional Server 
Components: 

o Vault Professional ADMS (Autodesk Data Management Service) 
o Microsoft IIS (required for Autodesk ADMS) 
o Microsoft SQL Server 2008 R2 

 
The Autodesk Network License Manager Service is installed and is named “Autodesk License 
Manager”. Restart this service in the event of problems obtaining a network License within the 
Buffalo facility. 
 

Asia RYC-VAULTc 
Vault Professional Server 
Components: 

o Vault Professional ADMS (Autodesk Data Management Service) 
o Microsoft IIS (required for Autodesk ADMS) 
o Microsoft SQL Server 2008 R2 

 
Autodesk Network License Manager is not currently installed, as there are no floating network 
licenses deployed at this location. 
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Server (RYC-VAULTa) Administration Task Details 

Check Autodesk Network License Status 
The Autodesk FlexLM licensing service runs in the background on each file server and automatically 
manages available licenses for all Autodesk products that were purchased as network (floating) licenses. 
Any Autodesk products licensed as “Standalone” are not affected in any way by this licensing service. 
 
The LMTOOLS utility on each server provides the management interface for configuring the service and 
also allows administrators to view the available licenses and licenses that are in use at any point in time. 
 
Start->All Programs->Autodesk->Network License Manager->LMTOOLS or, launch it from the “Autodesk” 
toolbar added to the status bar on the server. 

Figure 1 - LMTOOLS Utility 

 
 
Once the license service is configured properly with a valid license file (obtained from Autodesk 
Registration at time of product installation), there is really no ongoing administration required.  
Workstations in each RYC location are configured to get licenses from the applicable local file server 
(RYC-VAULTa, RYC-VAULTb, or RYC-VAULTc).  As shown in Figure 1, the LMTOOLS utility can be used to 
see how many licenses are currently in use, and which users have the licenses reserved. Go to the 
“Server Status” tab, and click on “Perform Status Enquiry”. Scrolling through the results window below 
the button will provide a list of installed licenses and current users. 
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Verify Vault Professional Replication Status among RYC Sites 
The “Sites” node in the tree at left brings up a tab (see Figure 2) that shows the current status of the file 
replication among all configured sites. Monitoring this page periodically is recommended to make sure 
that replication has been running successfully via the nightly scheduled task. 
 

Figure 2 - ADMS Console: Sites tab monitors replication status (Example) 

 
 
 

If an unusually large number of files 
remain to be replicated, it could 
possibly indicate a problem with the 
replication mechanism and should be 
investigated promptly. Typically, one 
should only see a single day’s worth of 
file changes waiting to be replicated.  
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Add a New Vault Professional User Account 
In order to add a new user to the Vault Professional system, the user must first be added to the RYC 
Active Directory. The user must also be added to the appropriate Active Directory group for Vault 
Professional permission assignments. Once the user account has been created in Active Directory and 
assigned as a member of the appropriate AD group, the account can be imported into Vault 
Professional.  This operation should be performed from the Vault Professional server.  
 

Change Vault Professional Permissions for a User 
The ADMS Console is installed with the Autodesk Data Management Server, and is used to administer 
and monitor the Vault Professional server components, including Vault backups and site-to-site 
replication, along with user accounts and group assignments.  Start->All Programs->Autodesk->Autodesk 
Data Management->Autodesk Data Management Server Console 2017.  The ADMS Console is the 
preferred tool to use for administration of Users and Groups for Vault Professional.  

Figure 3 - ADMS Console: User and Group Administration 

 
 
For RYC, Vault Professional is configured to use Windows Authentication. Users and groups from RYC’s 
Active Directory network domain are used for authentication to Vault Professional as well. Active 
Directory user accounts must be imported to Vault Professional.  Vault Professional Vault access is 
configured by adding or removing users in the appropriate Active Directory groups. 
 
IMPORTANT NOTE: Once Active Directory group membership has changed, it is necessary to “Update” 
the corresponding group in the ADMS Console “Administration” dialog as follows. 
Choose Tools->Administration in ADMS Console. 
 
 
 
 
 
 
 
 



  

RyourCompany | Server (RYC-VAULTa) Administration Task Details 13 
 

Figure 4 - ADMS Console Administration dialog - Group Membership 
Select the “Groups” button as shown in Figure 4. 
 
 
 
 
 
 
 
 
 
 
 

Figure 5 - Update Domain Group membership (Example) 
Right-click on the group that was updated in Active Directory and select “Update Domain Group” 
as shown in Figure 5. This will synchronize the group membership in Vault Professional and make 
the group membership changes take effect. 
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Verify Vault Professional Backup Integrity 
A critical part of maintaining the Vault Professional system is regularly verifying proper operation of the 
site-to-site replication function and verifying that good, reliable backups are being made every evening 
by the scheduled backup script.  The Vault Professional backup script is only run on the RYC-VAULTa 
server in the Americas. It is not necessary (and in fact, not available) on servers at remote sites. The 
Vault Professional ADMS backup script makes a full snapshot backup of the Vault Professional database 
and all files in the vault. These backups are sufficient for a full disaster-recovery restore.  It is still 
recommended that remote sites perform a normal file system backup of the Vault Professional file 
store.  In the event of a crash of a remote site Vault Professional server, it would take a huge amount of 
network bandwidth and many hours to recreate the file store cache from scratch.  Ensuring that a local 
file store backup exists would allow the rebuilding of a remote facility Vault Professional server in a very 
short amount of time, as the re-synchronization would only need to transfer files changed since the local 
backup of the file store. No separate Vault Professional backup function is required at remote sites.   
 
 
 
 
 

Backup Check Procedure  
In Export, a regular check should be performed to make sure that the ADMS backup script is functioning 
properly every night.  First, the ADMS Backup Log can be checked for errors. The log resides in \\RYC-
Vaulta\Backup\VaultBackup.log , but can be quickly accessed from the “Autodesk” toolbar configured 
on the RYC-VAULTa taskbar. 
 
Scroll to the bottom of the file in Notepad and make sure the most recent backup date and time is 
correct. The backup should be from the night before. A normal, valid backup will look similar to 
the following in the log.  It is normal to see “Vacuum Cleaner” operations and occasionally entries 
saying “Replicating resource named…” in the log. Make sure that all databases were backed up 
with no obvious errors. 
 
Next, check the backup files themselves by looking in the \\Vault\Backup\A  and  \\RYC-Vault\Backup\B 
folders. The folder under the “A” folder should reflect the date and time of the most recent backup (the 
night before), and the “B” folder should contain a folder that reflects the date and time of the backup 
immediately before that one.   
 
These backups are rotated every night, with the “A” folder always containing the most recent backup. 
Make SURE that the date and time of the backup folders is current and correct. If any problem should 
occur with the Windows Scheduled Task that runs the backup script, the backups would stop and the 
date and time of the backups would be old and out of date.  
 
Check this regularly for proper backup operation.  It also would be a good idea to right-click on the “A” 
and “B” folders in Windows Explorer and select Properties on each. Make sure the total size of the 
backup is in the range that makes sense—for example, as of May, 2017, the backups are roughly 23GB in 
size.  A backup that was suddenly 9GB in size would reflect a problem... 
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Autodesk Product Design Suite Deployment(s) – Installation Process 

Americas - Install a New Inventor 2017 Workstation 
1. Log in to the new workstation as Administrator or a user with local administrative privileges.  

Determine the appropriate Product Design Suite 2017 deployment – based on whether this 
machine gets a Standalone license or shares a floating Network license.  You also must select the 
appropriate version of Product Design Suite Standard 2017, Product Design Suite Premium 2017 
or Product Design Suite Ultimate 2017. Contact RyourCompany  I.T. or Cad Administration with 
any questions related to licensing.  
 
 
 
 
 
 
    Example: 
 

2. 2017 Deployments are as follows:  
   

a. Product Design Suite Premium 2017 Network: 
\\RYC-VAULTA\RYC_Deployments\2017\PDSP2017_N_Deploy  

 
b. Product Design Suite Ultimate 2017 Network: 
\\RYC-VAULTA\RYC_Deployments\2017\PDSU2017_N_Deploy  

 
c. Autocad Electrical 2017 Network: 
\\RYC-VAULTA\RYC_Deployments\2017\ACADE2017_N_Deploy  
 
d. Autocad LT 2017 Standalone 
\\RYC-VAULTA\RYC_Deployments\2017\ACADLT2017_S_Deploy  

 
e. Autodesk Vault Professional 2017 Network 
\\RYC-VAULTA\RYC_Deployments\2017\VPclient2017_N_Deploy  

 
f. Autodesk P&ID 2017 Network 
\\RYC-VAULTA\RYC_Deployments\P&ID2017_N_Deploy  

 
3. Run the correct deployment from the list above by simply double-clicking the shortcut. The 

installation will run silently with no prompts and will require some time to complete 
(approximately 20-40 minutes on average). 

4. After completion…  Drag a COPY of the “AutoCAD 2017” shortcut from the Start menu to 
C:\Documents and Settings\All Users\Desktop 

 
 

file://FSE-VAULTEX/FSE_Deployments/2017/PDSP2017_N_Deploy
file://FSE-VAULTEX/FSE_Deployments/2017/PDSU2017_N_Deploy
file://FSE-VAULTEX/FSE_Deployments/2017/ACADE2017_N_Deploy
file://FSE-VAULTEX/FSE_Deployments/2017/ACADLT2017_S_Deploy
file://FSE-VAULTEX/FSE_Deployments/2017/VPclient2017_N_Deploy
file://FSE-VAULTEX/FSE_Deployments/P&ID2017_N_Deploy
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ALL OPERATIONS BEYOND THIS POINT REQUIRE BEING LOGGED IN UNDER THE ACTUAL USER 
ACCOUNT. These settings are applied to the user’s Windows profile and must be performed as 
the actual software user.  
 

1. Log into Windows as the user who will be using the Autodesk software. 
2. Launch Vault Professional 2017 Client 
3. Log in to Vault Professional by selecting Windows Authentication AND Automatically Log in 

a. (If login problems occur as the user, the required new user account has probably not 
been imported from Active Directory in the ADMS Console on the Vault Professional 
server. See “Add a New Vault Professional User Account” later in this document.) 

4. Select the ”File” pull-down menu and click “Set Working Folder” 
5. Select “C:\” as the working folder and click “OK”. 
6. On the “Tools” pull-down menu go to “Options” and place a checkmark beside the first two 

checkboxes at the top. Click “Ok” to save changes and close the Options dialog. 
7. Click on the “RYC” folder in the tree on the left. 
8. Right-click on “RyourCompany .ipj” in the list of documents and select “Get Latest Version”. 

Click “OK” to accept the file download. 
9. Close Vault Professional 2017 Client. 
 
Launch Inventor 2017 
 
1. In Inventor, go to the Tools pulldown menu and select “Application Options” 
2. Click the “Import” button at the bottom of the form and import from: 

\\RYC-VAULTa\RYC-Standards\ApplicationOptions2017.xml 
3. On the “General” tab on the same form, set USER NAME to the user's network login name (in 

lower case) and click “Apply” On the same form, go to the “File” tab - set PROJECTS FOLDER to 
“C:\_Workspace” (no quotes) 

4. Click “OK” to accept changes and close the Application Option dialog. 
5. In Inventor, go to File->Projects and activate the "RyourCompany .ipj" project by double clicking 

it in the list. Click “Ok” to close the Projects dialog. 
6. On the “File” pull-down menu, go to “Autodesk Data Management Server”->”Log In”. Check 

"Windows Authentication" AND "Automatically Login Next Session" and click “Ok” 
7. Verify presence of RYC templates by clicking "New". You should see available RYC Templates. 

 
CONFIGURE AUTOCAD (installed as a component of the Inventor deployments) 
1. Launch AutoCAD 2017 from the shortcut copied to the desktop earlier (Plain AutoCAD 

2017, not AutoCAD Mechanical 2017) 
2. Type OPTIONS and press enter. 
3. Go to the Profiles tab and select “Import” 
4. Import \\RYC-VAULTa\RYC-Standards\Autocad\RYC AutoCAD 2017 Vanilla.arg 
5. Enter "RYC AutoCAD 2017 Vanilla" as Description 
6. Click “Ok” to import 
7. Select the newly imported profile in the list and click “Set Current” 
8. Select the “<<VANILLA>>” profile in the list and click “Delete” 
9. Select the newly imported profile again and click “Rename” 
10. Enter <<VANILLA>> (exactly like this with the brackets) as the profile name 

file://fse-vaultex/FSE-Standards/Autocad/FSE%20AutoCAD%202013%20Vanilla.arg
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11. Click Ok 
12. Select the new <<VANILLA>> profile in the list and click “Set Current” 
13. Click “Ok” to close the Options dialog. 
14. Close AutoCAD 2017 

 
 

Repeat deployments for Europe and China…………………………………………………. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Autodesk Inventor and Vault Professional Configuration 

Autodesk Inventor Application Options 
A default set of application options will be produced on the server to import at installation time.  See 
\\RYC-VAULTa\RYC-Standards\applicationOptions2017.xml.  

file://fse-vaultex/FSE-Standards/applicationOptions2013.xml
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o General Tab 
• After Importing .xml file Add User name 

 
o Save Tab 

• Add Check marks for 

 
o File Tab 

• Add 

 
o Colors Tab 

• Leave as Default 
o Display Tab 

• Leave as Default 
o Hardware Tab 

• Set as Performance 
• Open file and test diagnostics 

o Prompts Tab 
• Leave as Default 

o Drawing Tab 
• Confirm .idw 
• Confirm Autocad 2017 

o Notebook Tab 
• Leave as Default 

o Sketch Tab 
• Uncheck all but Axis 

 
 

• Add Check mark for Edit Dimension 
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o Part Tab 

• Leave as Default 
o iFeature Tab 

• Confirm path structure 

 
o Assembly Tab 

• Add Check Marks as follws 

 
o Content Center Tab 

• Vault Access should be through the server 

 
 

Save as ApplicationOptionsRYC.xml at \\RYC-VAULTa\RYC-Standards  

file://fse-vaultex/FSE-Standards
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Vault Professional Configurations 
 
All of the Vault configurations will take place through the ADMS Console on Server RYC-VAULTA.  
RyourCompany will for some time have multiple databases and therefore will not lock down the 
Working Folder.   
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o Set Working Folder (Not at this time, but in the future) 
o Security 

• Domain Name implementation for ALL 
 

o Lifecycle State Workflows 

 
o Categories  

• Folder 
• Files 

 
 
 
 
 
 
 
 
 
 
 
 
 

o Engineering Change Notifications 
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o Routing Lists 

 
o File Naming Schemes 
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Vault Roles & Permission Levels 
 
  

The Autodesk vault server is a secure database. A user must have an account to access data and must be assigned 
appropriate user permissions. Permissions are assigned based on roles. When more than one role is assigned, the 
permission set is the union of the roles, extending the permissions of the user or group. 
  

Administrator Full privileges with all folders all the time and administrative privileges on 
the server. These privileges include the Job Server in Vault Workgroup, 
Vault Collaboration, and Vault Professional. In Vault Professional, the 
administrator also has ERP rights. 

Content Center Administrator Full privileges within the Content Center and library management 
privileges on the server (within the server console). These privileges 
include create, delete, import, export, and defragment libraries. This role 
does not apply to Civil 3D users. 

Content Center Editor Full privileges within the Content Center, but no administrative privileges 
on the server (within the server console). This role does not apply to Civil 
3D users. 

Document Consumer Read-only access to files and folders only, including the job server queue. 

Document Editor Level 1 Basic file adding and editing privileges within the vault, but cannot delete 
files and folders. No administrative privileges on the server. 

Document Editor Level 2 Full privileges within the vault, but no administrative privileges on the 
server. 

Document Manager Level 1 (Vault 
Workgroup, Vault Collaboration, and 
Vault Professional) 

The privileges to change category, lifecycle, and revision assignments, and 
to edit user-defined properties. 

Document Manager Level 2 (Vault 
Workgroup, Vault Collaboration, and 
Vault Professional) 

Full file behavior management privileges within Autodesk Vault, including 
the ability to add, remove, and edit user-defined properties. This role 
does not have the ability to create behavior definitions. 
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ERP Manager (Vault Professional) Performs ERP tasks:  Configure and manage the MSMQ DWF queue 
settings.  Import ERP: Import an item from an ERP system into 
Professional. Export ERP: Export items for use with an ERP system. 

Item Editor Level 1 (Vault 
Professional) 

Basic file and item privileges within Professional, but cannot delete files, 
folders, or items. No administrative privileges on the server. 

Item Editor Level 2 (Vault 
Professional) 

Full privileges within Professional except for change orders. No 
administrative privileges on the server. 

Item Reviewer (Vault Professional) Read-only access to items, files, and folders. 

Change Order Editor (Vault 
Professional) 

Create, edit, participate, and read change orders.NoteThese permissions 
previously existed in the Item Editor Level 1 & 2, Item Reviewer, and ERP 
Manager roles and have been removed so that only the Change Order 
Editor and Administrators can create or largely modify change orders. 
Upon migration, all users assigned Item Editor, Item Reviewer, and ERP 
Manager roles will also be assigned the Change Order Editor role. 
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Installation Schedule 

Engineering Cad  
o Inventor and Vault Pro install 
o Vault Pro installs 

Engineering 
o Inventor and Vault Pro install 
o Vault Pro installs 

Product Controls  
o Autocad and Vault Pro install 
o Vault Pro installs 

CNC 
o Autocad and Vault Pro install 
o Vault Pro installs 

Document Controls 
o Autocad and Vault Pro install 
o Vault Pro installs 

Production Controls 
o Autocad and Vault Pro install 
o Vault Pro installs 

Purchasing 
o Autocad and Vault Pro install 
o Vault Pro installs 

Marketing 
o Autocad and Vault Pro install 
o Vault Pro installs 

Sales 
o Autocad and Vault Pro install 
o Vault Pro installs 

Services\Aftermarket 
o Autocad and Vault Pro install 
o Vault Pro installs 

 
 
*** Approx. 75+ Installations that are needed at RyourCompany  Company. 
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RyourCompany Cad Station  

Floor Plans 

Product Engineering/Drafting and Development (2nd Floor) 

Project Engineering/Drafting (1st Floor)  

CNC (1st Floor) 

Product Control (2nd Floor) 

Marketing (3rd Floor) 

Shop Floor 
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System Configuration Form 
2017 User Stations 

User Workstation 
 

o User Name:  _______________________________ 
 

o User Department:  _______________________________ 
 

o Product Design Suite:  _______________________________ 
 

o Vault Pro:  _______Y/N____________ 
 

o Confirmed all Configurations:  __Y/N___ 
 

o Needs Training w/:  
o Inventor Update Training ___ 
o Vault Professional Training ___ 
o Autocad Update Training ___ 
o Autocad Electrical Training ___ 

User Workstation 
 

o User Name:  _______________________________ 
 

o User Department:  _______________________________ 
 

o Product Design Suite:  _______________________________ 
 

o Vault Pro:  _______Y/N____________ 
 

o Confirmed all Configurations:  __Y/N___ 
 

o Needs Training w/:  
o Inventor Update Training ___ 
o Vault Professional Training ___ 
o Autocad Update Training ___ 
o Autocad Electrical Training __ 
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RYC Training – Americas 

Overview 
Training on updated applications is essential to productivity.  The main focus is towards Drafting and 3D 
Inventor.  Secondly is training for Vault Professional which will includes Drafting, Engineering, CNC, 
Purchasing, Product Control and later all others at RyourCompany .  There will be department 
orientation to explain the updates that are taking place.   

Vault Professional 
o Drafting Personnel 
o Engineering Personnel 
o Management Personnel 
o Manufacturing 
o CNC 
o Product Control 
o Purchasing 
o Sales 

Four Hour Sessions pertaining to specifics of each type of group. 

Autodesk Inventor Update 
o Product Drafting/Engineering/Development 
o Project Drafting/Engineering 

o Four Hour Sessions pertaining to specifics of each type of group. 

Autocad Update 
o Not at this time 

 
 

************************************* Orientation **************************** 
o (Possibly Split into segments) 

o Company Orientation - 30 minutes 
 Product Engineering 
 Project Engineering 
 Product Control 
 CNC 

*** This orientation will on a high level explain what is new on their systems, what typical 
workflows to continue with and what new processes and workflows are coming.  Vault 
Professional Domain Logins will be explained. 
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Vault Professional 2017 Basic New workflows 
 Go over in the Orientation 

Inventor 2017 Update Training 
o Set schedule 

 Am session 8:00 – 12:00 =  
 Pm session 1:00 – 5:00 =  

 
o Set schedule 

 Am session 8:00 – 12:00 =  
 Pm session 1:00 – 5:00 =  

 

Vault Professional 2017 (Lifecycle States & ECN’s) 
o Set schedule 

 Am session 8:00 – 12:00 =  
 Pm session 1:00 – 5:00 =  

o Set schedule 
 Am session 8:00 – 12:00 =  
 Pm session 1:00 – 5:00 =  

o Set schedule 
 Am session 8:00 – 12:00 =  
 Pm session 1:00 – 5:00 =  
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